Welcome to ClaroRead
Welcome to ClaroRead Mac. ClaroRead is designed to help make your computer easier to use. It is closely
integrated with Pages and Microsoft Word to assist you as you work with text.
ClaroRead adds powerful speech features which allow you to listen to any information depicted on your computer
screen.
ClaroRead will work alongside any application on your computer.

The ClaroRead Toolbar

Please use the index on the left hand side to navigate through this help book.

ClaroRead Toolbar

The ClaroRead toolbar is accessed by selecting ClaroRead in /Applications:

Using the ClaroRead toolbar, most text on the computer screen can be read out to you from any application using
the buttons on the toolbar.
Once open, the above toolbar will be displayed and can be moved around the screen by clicking the title bar and
dragging it to where you want it.
You can also dock the toolbar to the top of the screen by dragging it into the menu bar. Here you'll find quick access
to the main ClaroRead features:

Watch a video of this feature in action on the View Settings page.

ClaroRead Toolbar Buttons
The Play button is used to read out a Pages or Microsoft Word document, starting from
where the cursor is positioned. Simply select where in the document you want the reading to
start and click the Play button.
In other programs, clicking on the Play button will speak the selected text. So to use the Play
button in TextEdit, for example, you need to select the text and click on the Play button.

The Stop button is used to stop the speech at anytime when clicked.

Clicking on the Scan button will allow you to use OCR to convert inaccessible documents
and text into an accessible format. See the Scan section for more information.

Clicking on the Dictate button will start the Mac's built-in dictation feature. Any text you speak
will be written into the application you're currently working in. Click the Done button when
you're finished.

Clicking on the Font button will allow you to format text in Pages and Microsoft Word. See
the Font section for more information. The Font button is hidden by default, you can show it
by editing the View Settings.

Clicking on the Spacing button will allow you to format the spacing in Microsoft Word. See
the Spacing section for more information. The Spacing button is hidden by default, you can
show it by editing the View Settings.

Clicking the Check button in Pages or Microsoft Word will check the current word for spelling
errors, homophones, or show you the meaning of the word. To spell check the whole
document, click Spell Check All in the Check window.
Clicking the Check button in any other application will spell check all of the selected text.
See the Check section for more information.

Clicking on the Homophones button will check for homophones and spelling errors in your
Pages or Microsoft Word document.
Clicking the Homophones button in any other application will check for homophones and
spelling errors in the selected text.

See the Homophones section for more information.

Clicking the Predict button will toggle on/off ClaroRead's word prediction feature. See the
Prediction section for more information.

Clicking on the Save Audio button allows you to save speech to audio file.
In Pages or Microsoft Word, if text is selected, it will save the selected text. If no text is
selected it will save the whole document.
In any other app it will save what text is selected.
Clicking on Save Audio will open a Save to File dialog box which allows you to choose
where the file is saved and what it is called. If you wish to convert the audio file to another
format, please refer to the Converting Audio Files page.

The Extras button is a handy link to other programs and websites. See the Extras section for
more information.

Clicking on the Settings button will open the ClaroRead Settings.

The close button in the top left corner will close ClaroRead. Alternatively, use the shortcut key
⌘Q.

Scan

The Scan button allows you to read text from paper scanned in via a scanner, from a PDF or image file or from an
area of the screen. If you have Readiris installed, you can also launch that from the toolbar.

Scan from Paper
This will open the Mac's Image Capture program to enable you to scan in a document using a scanner or other
imaging device. Once scanned in, ClaroRead will turn the image into a text accessible document ready to be read
back to you.

Scan from PDF/File
Select this option to convert a PDF file or image file into an accessible document to be read back to you.

Scan from Screen
Once you select Scan from Screen, the screen will dim slightly to show you it's in capture mode. Click and drag the
selection rectangle over the text you want to process. Once you release the mouse button, the text will be copied to
the clipboard and read out to you (if it is set to do so in the Voice settings).

Font

The font options are only available when working in Pages or Microsoft Word.
The following explains each of the font formatting options:

Increase Font
Clicking the Increase font option will increase the font size of the document's text.

Decrease Font
Clicking the Decrease font option will decrease the font size of the document's text.

Comic Sans MS
Clicking the Comic Sans MS option will change the document font to Comic Sans MS.

Trebuchet MS
Clicking the Trebuchet MS option will change the document font to Trebuchet MS.

Arial
Clicking the Arial option will change the document font to Arial.

Font Colour
If you wish to change the colour of the text, first select the text, then select Font > Font Colour and select the colour
you want.

Highlight Colour (Microsoft Word only)
If you wish to highlight text with a colour, first select the text you want highlighting and then select Font > Highlight
Colour and select the colour you want.

Spacing

The spacing options are only available when working in Microsoft Word.
The following explains each of the spacing formatting options:

Change Character Spacing
Clicking the Change Character Spacing option will change the spacing size between each text character.

Change Line Spacing

Clicking the Change Line Spacing option will change the spacing size between each line.

Change Paragraph Spacing
Clicking the Change Paragraph Spacing option will change the spacing size between each paragraph.

Check

Checking Text in Pages and Microsoft Word
To check the current word, place the cursor at the beginning of the word and click on the Check button.
If you want to spell check the whole document, click on the Spell Check All button in the Check window. If you want
to do a full spellings and homophone check on your document, use the Homophones button instead.
The following screen will appear if it is a spelling error:

Click the plus button next to the original word if it is not actually misspelled and you would like to add it to the
dictionary. Click the plus button next to the suggestions list if you would like to add your own correction.
The following screen will appear if it is a homophone:

The following screen will appear if it is neither a spelling error nor homophone:

You can select alternative words/spelling suggestions and view their meanings to ensure you have the correct word.

Check Window Buttons
Clicking on the show/hide icon in the top right corner will show or hide the extra information panel which displays
a dictionary definition and the context of the current word.

Clicking on the speaker icon next to the show/hide icon will allow you to control whether or not the text under
the mouse of the Check window is spoken automatically when you hover the mouse over it.
Click on the Ignore button to ignore the current word and leave it unchanged.
Click on the Change button to change the word to the one selected in the alternatives list if you have found that you
have originally typed the wrong word.
If you want to spell check the whole document, click on the Spell Check All button.
Click on the Close button if you wish to return to your document without changing anything.
Click on the Lookup... button to view the dictionary definition of the currently selected word.

Spell Checking Text in Other Applications
When writing in applications other than Pages or Microsoft Word (e.g. TextEdit), you can spell check text by selecting
the text and clicking the Check button. ClaroRead will then check the text and display the Check window if a spelling
error is found. Once checking is complete, ClaroRead will apply your changes to the text.

Homophones

Homophone and Spell Checking Text in Pages and Microsoft Word
The Homophones button is a more in-depth check of your document compared to the Check button. It will start with
where your cursor is in the document and stop on every word which is a homophone or spelling error, so you can
make sure your text is completely correct.
The following screen will appear if it is a homophone:

The following screen will appear if it is a spelling error:

Click the plus button next to the original word if it is not actually misspelled and you would like to add it to the
dictionary. Click the plus button next to the suggestions list if you would like to add your own correction.

Check Window Buttons
Clicking on the show/hide icon in the top right corner will show or hide the extra information panel which displays
a dictionary definition and the context of the current word.

Clicking on the speaker icon next to the show/hide icon will allow you to control whether or not the text under
the mouse of the Check window is spoken automatically when you hover the mouse over it.
Click on the Ignore button to ignore the current word and leave it unchanged.
Click on the Change button to change the word to the one selected in the alternatives list if you have found that you
have originally typed the wrong word.
If you want to spell check the whole document, click on the Spell Check All button.
Click on the Close button if you wish to return to your document without changing anything.
Click on the Lookup... button to view the dictionary definition of the currently selected word.

Homophone and Spell Checking Text in Other Applications
When writing in applications other than Pages or Microsoft Word (e.g. TextEdit), you can homophone and spell check
text by selecting the text and clicking the Homophones button. ClaroRead will then check the text and display the
Check window if a homophone or spelling error is found. Once checking is complete, ClaroRead will apply your
changes to the text.

Prediction

To switch on prediction, click on the button on the toolbar. The button will now appear 'pushed in'. To switch
prediction off, click the button again. The button will now look normal again.
If prediction is switched on, when you type in any program ClaroRead will suggest possible words that you might be
trying to type.

If you see the correct word in the prediction suggestion window that you would like type you can either press the
corresponding F-key or click on the word with the mouse. If the F-keys do not complete the word for you, ensure you
have the correct system settings to enable standard use of the F-keys, instructions of how to do this can be found in
the Support section.
You can make the text in the prediction window larger or smaller by clicking on the bottom right corner of the
window and dragging to resize the window.
More suggestions can be viewed by clicking on the down arrow
window.

in the bottom right corner of the prediction

There are many prediction settings that you can configure to suit you best. You can also train the prediction
dictionaries from existing documents. See the Prediction Settings section for more information.

Extras

If installed the Extras menu will show:
Auto Converter: automatically OCRs files dropped into a particular folder.
Calculator: the Mac's built in Calculator.
ClaroCapture: study Skills tool allowing you to capture text from many places into one project.
ClaroIdeas: mind mapping software.
ClaroPDF: open PDF files and have them read back to you with synchronised highlighting.
ClaroSpeak: open PDF files and other documents in ClaroSpeak and have them read back to you with
synchronised highlighting.
ClaroView: screen tinting software.
ScreenRuler: a handy 'ruler' bar which follows the mouse, allowing you to focus more easily on the active area
of the screen.
The Extras menu also has an Edit option which opens the Extras Editor:

In the Editor you can remove any default Extra apps you don't need and add in any other applications you use often.
You can also add links to websites that you need quick access to.

ClaroRead Settings

You can change ClaroRead's settings by clicking on the Settings button on the toolbar, clicking on the menu bar at
the top (ClaroRead > Preferences), or by using the shortcut key ⌘,

From this settings screen you can alter the speech, highlight, view, check, prediction and scan settings.

Speech Settings
From the Speech tab in the Settings, you can alter Voice and Pronounce settings.

Voice Settings

From the above screen you can alter many speech options:

Voice
You can change the voice name and speaking rate. Use the Play button to test out the current voice settings.

Echo
You can set whether ClaroRead echoes characters, words and/or sentences when you type.
If characters is checked, you can click on the Edit button next to it to choose whether the characters are echoed like
in the alphabet (a = ay) or phonetically (a = ah).

You can also set whether ClaroRead will automatically speak back the text that has been entered using the Dictate
button on the main toolbar. Please note: this will only work if you dictate text into Microsoft Word, Pages or TextEdit.
In order for keyboard echo to work, you must ensure that ClaroRead is enabled for accessibility. To learn how to do
this, look in the Support Questions & Answers section.

Reading
You can set ClaroRead to insert a pause between each word and/or stop at the end of each sentence.

Mouse
You can set ClaroRead to automatically read out text when you select with the mouse and/or speak when you hover
the mouse pointer over some text. If you find mouse hover speaks too much, there is also an option to only speak
using mouse hover when Safari is the current application.
When you use the Scan from Screen feature, the result will be automatically spoken back if Speak when mouse
selects is checked.
In order for mouse hover to work, you must ensure that ClaroRead is enabled for accessibility. To learn how to do
this, look in the Support Questions & Answers section.

Pronounce Settings

Sometimes speech synthesisers can pronounce words incorrectly, usually people or place names. From the above
screen you can alter the pronunciation of certain words.

Add
Click on the + button to add a new pronunciation entry.

Remove
Click on the - button to remove the currently selected pronunciation entry.

Edit
Click on the list to change a current entry.

Test
You can test the old and new pronunciations by clicking on the relevant button above the list.

Highlight Settings

From the above screen you can alter the synchronised highlighting options:

Synchronised Highlight
You can set how ClaroRead highlights in Pages and Microsoft Word when you press the Play button.
Word: this highlights each individual word one at a time.
Word trail: this highlights each individual word but does not unhighlight the previous words until the end of
the sentence.
Sentence: this highlights each sentence one at a time.
Paragraph: this highlights each paragraph one at a time.
Focus sentence: this option greys/masks out the whole document except the current sentence when
ClaroRead is reading, drawing your focus to the current sentence.

Synchronised Highlight Colour
You can change the text and background colour of the highlighted words when you press the Play button.
The Show Background Colour check box determines whether to include the background colour when highlighting.
Please note: Background highlight colour is only used in Microsoft Word.

View Settings

In the View settings, you can choose which buttons are shown on the toolbar, what size the toolbar icons should be
displayed as, and whether or not to show the text captions under the icons.

If you want to hide the toolbar completely and have access to the main features from the menu bar along the top of
the screen, simply click on the ClaroRead toolbar and drag it into the menu bar area.

Check Settings
From the Check tab in the Settings, you can alter Homophone and Spelling settings.

Homophone Settings

From the above screen you can alter the list of homophones used in ClaroRead.

Add
Click on the + button to add a new homophone entry.

Remove
Click on the - button to remove the currently selected homophone entry.

Edit
Click on the list to change a current entry.

Spelling Settings

ClaroRead uses Microsoft Word's spelling suggestions when working in Microsoft Word, and when working in other
applications it uses the Mac's in-built spelling dictionary. However, you may wish to add some common corrections
which ClaroRead may not suggest. From the above screen you can alter the additional list of spellings suggested by
ClaroRead when you use the Check button. The words in this list will appear at the top of the spelling suggestions
list in the ClaroRead Check window.

Add
Click on the + button to add a new spelling entry.

Remove
Click on the - button to remove the currently selected spelling entry.

Edit
Click on the list to change a current entry.

View Spelling Report
When you use the Check button in ClaroRead and correct spelling errors, ClaroRead records this and the report can
be viewed by clicking the Spelling Report button.

From the above report you can select an entry and click on the Transfer to Spelling list button to add the entry to
the custom list of spelling suggestions.

Prediction Settings
From the Predict tab in the Settings, you can alter General and Predict Window settings and train the dictionaries.

General Prediction Settings

From the above screen you can alter the way prediction works.

Prediction Dictionary
Choose which prediction dictionary ClaroRead should use from the list.
Add a new blank prediction dictionary by clicking on the + button.
Delete the currently selected prediction dictionary by clicking on the - button.
Edit the words in the currently selected prediction dictionary by clicking on the Edit button.

Learn Prediction
There is a range of settings you can change which alters how ClaroRead learns words:
Automatically add new words: this setting means that all words will be added to the prediction dictionary as
you type them.
Spell check before adding: this setting means that all words will be spell checked before being added to the
prediction dictionary. You need to have Microsoft Word open for this setting to work.
Learn frequency: this setting means that as you type words, ClaroRead will remember the number of times
you have typed them and can suggest the most frequent words towards the top of the suggestion window if
you have the Order by likelihood setting switched on in the Window tab.
Learn word order: this setting means that ClaroRead will learn the order in which you type words so can
suggest some relevant next words to you if you have the Next word setting switched on in the Window tab.
Save dictionary on exit: this setting means that the prediction dictionary will save all your changes when you
exit ClaroRead.

Prediction Window Settings

From the above screen you can alter the settings of the pop up prediction suggestion window.

Order suggestion list
You can choose whether the prediction suggestion window orders the suggestions alphabetically or by likelihood.

Show
You can choose whether the prediction suggestion window continues to show words which you have not chosen and
if ClaroRead should try to predict the next word when you complete a word.
You can also choose whether or not the prediction window shows a picture next to each suggested word.

Prediction list colour
You can alter the text and background colour of the prediction suggestion window.

Prediction Training

From the above screen you can train the current prediction dictionary in ClaroRead.

Training the dictionary
1. Choose where you want to train the dictionary from: Microsoft Word, Pages or the Clipboard.
2. Choose whether ClaroRead should learn new words, the frequency of words and/or the word order from the
text.
3. Click the Begin Training button
A progress bar will appear showing you how far through the text the training has got.
Training will take a long time on large documents.
You can cancel training at any point by clicking on the Cancel Training button. ClaroRead will stop
training and save the data it has already learnt before you clicked cancel.

Scan Settings

From the above screen you can alter how ClaroRead's scan function behaves.

Scan Language
This option sets the language of the OCR used when you scan from screen, paper and file.

Scan Result
View result sets whether or not ClaroRead should open the result file either in the default application (e.g. Word,
Adobe) or in the ClaroSpeak app which enables you to open files (e.g. PDF) and have synchronised speech and
highlighting.

How do I...?
This section provides a handy guide to common ClaroRead operations. Find out how to:
Make text speak in Pages or Word
Make text speak in Safari
Make text speak in other applications
Make the Calculator speak
Convert audio files into other formats (e.g. MP3)
Control ClaroRead using the keyboard
Control ClaroRead using the dock icon menu

Make text speak in Pages or Microsoft Word

You can get text in Pages or Microsoft Word to speak in three ways:
1. Place the cursor where you would like ClaroRead to start reading from and then click on the Play button.
ClaroRead will start to read and highlight the words as set in the Highlight settings tab.
2. Switch on Speak when mouse selects on the Voice settings tab. Now select the text you would like to hear
using the mouse. When you let go of the mouse button, ClaroRead will automatically speak the text back to
you.
3. Switch off Speak when mouse selects on the Voice settings tab. Now select the text you would like to hear
using the mouse and then click the Play button. ClaroRead will now speak the selected text back to you.

Make text speak in Safari

You can get text in Safari to speak in three ways:
1. Switch on Speak on mouse hover on the Voice settings tab. Now point the mouse cursor at some text in
Safari. The text will automatically be read out to you if it is accessible.
2. Switch on Speak when mouse selects on the Voice settings tab. Now select the text you would like to hear
using the mouse. When you let go of the mouse button, ClaroRead will automatically speak the text back to
you.
3. Switch off Speak when mouse selects on the Voice settings tab. Now select the text you would like to hear
using the mouse and then click the Play button. ClaroRead will now speak the selected text back to you.

Make text speak in other applications

You can get text in other applications including Mail, Adobe Reader, Preview and others to speak in two ways:
1. Switch on Speak when mouse selects on the Voice settings tab. Now select the text you would like to hear
using the mouse. When you let go of the mouse button, ClaroRead will automatically speak the text back to
you.
2. Switch off Speak when mouse selects on the Voice settings tab. Now select the text you would like to hear
using the mouse and then click the Play button. ClaroRead will now speak the selected text.
You could also switch on Speak on mouse hover on the Voice settings tab and point the mouse cursor at the text.
The text will automatically be read out to you if it is accessible. As there are many third party software applications
available, we cannot guarantee this method will work with all applications.

If you would like synchronised speech and highlighting in other document formats, such as PDF, try opening them in
ClaroSpeak and using ClaroSpeak's Play button.

Make the Calculator Speak

To get the Mac Calculator to speak, follow these instructions:
1. Open the Calculator either from the Extras menu in ClaroRead or from the Applications folder.
2. Type your equation and ClaroRead will read out what you're typing.
3. When you hit Return or equals on your keyboard, ClaroRead will read out the result to you.

Convert Audio Files

After saving a document into AIFF/WAV you may wish to convert the file into another format for portability.
One of the ways you can convert audio files into other formats is to use the Apple Music app. In this example we will
convert into MP3 format. To perform the conversion you will have to make a one off settings change:
1. In Music's main menu select Preferences
2. Select the General tab
3. Select the Import Settings... button
4. Change Import Using to MP3 Encoder
Each time you wish to convert an audio file to MP3, you will need to do the following:
1. Open Music and drag the audio file into the library
2. Select the audio file
3. In the file menu along the top select File > Convert > Create MP3 version.
You are now able to transfer the MP3 file to a portable device of your choosing.
Please note: these instructions are correct based on Music version 1.0.5. For more information, please read Apple's
official support for this.

Keyboard Shortcuts
You can control most ClaroRead functions by using the keyboard and/or file menu. Play and Stop are system-wide
keyboard shortcuts and will work even when ClaroRead is not in focus. The rest are ClaroRead specific, so you will
need to get ClaroRead into focus by pressing ⌘ and tab until ClaroRead is selected. Below is a table of the
shortcuts:
Function

Shortcut

Play

⌘F7
⌘F8
⇧⌘S
⇧⌘V
⌥⌘P
⌥⌘F
⌥⌘S

Stop
Speak when mouse selects
Speak on mouse hover
Scan from Paper
Scan from PDF/File
Scan from Screen

Dictate
Check
Homophones
Predict
Save Audio
Extras (various)

⌘D
⌘K
⇧⌘H
⌘P
⇧⌘A
⌥⌘[number]

Dock Icon Menu
When ClaroRead is running, its icon appears in the Dock. If you do not want the toolbar to be visible all the time you
can hide it using ⌘+H and still access some main functions through the Dock icon menu.
Ctrl+click ClaroRead's Dock icon to bring up the menu:

From this menu you can:
Click Play
Click Stop
Click Save Audio
Show/hide the ClaroRead toolbar
Quit ClaroRead

Support Questions & Answers
Q: a) Why is the prediction window not showing when I type? The Predict button is switched on.
Q: b) Why does nothing get read out under the mouse pointer when Speak on mouse hover is checked?
Q: c) Why do the keyboard keys not get spoken when I type? Echo > Characters and Echo > Words are both
checked in Settings.
A: This may be because you have not enabled ClaroRead in the Accessibility settings. To rectify this, select the
Apple symbol in the top left corner of the screen and select System Preferences. Now select Security & Privacy
along the top:

The following screen will appear, ensure the checkbox next to ClaroRead is checked. You may have to click on the
padlock at the bottom first and enter your password.

Q: a) Why does nothing happen when I press the keyboard shortcut for Play and Stop?
Q: b) Why does nothing happen when I try to complete a word in prediction using the F-keys?
A: For these shortcuts to work you need to have Use all F1, F2, etc. keys as standard function keys checked in
System Preferences > Keyboard & Mouse:

Q: How can I reset the settings in ClaroRead?
A: To reset the ClaroRead settings, download and run our Restore Settings app.

Technical Support
If you require further support, please visit our support knowledgebase or email support@clarosoftware.com.

